Installation Guide
Mac OS X Operating Systems
Legal Notices

Published by Toon Boom Animation Inc.

Corporate Headquarters
5530 St. Patrick
Suite2210
Montreal, Quebec
Canada H4E 1A8
Tel: (514) 278-8666
Fax: (514) 278-2666
toonboom.com

Disclaimer

The content of this manual is covered by a specific limited warranty and exclusions and limit of liability under the applicable License Agreement as supplemented by the special terms and conditions for Adobe® Flash® File Format (SWF). Please refer to the License Agreement and to those special terms and conditions for details.
The content of this manual is the property of Toon Boom Animation Inc. and is copyrighted. Any reproduction in whole or in part is strictly prohibited.
For additional copies of this manual, please contact Toon Boom Animation Inc. at the Corporate Headquarters address.
Copyright © 2012 by Toon Boom Animation Inc. All rights reserved.

Trademarks

Toon Boom Harmony is a trademark owned by Toon Boom Animation Inc. All other trademarks are the property of their respective owners.

Credits

Documentation Development: Toon Boom Animation Inc., Peter Cawthorne, Pamela Grimaud
Content Development: Marie-Eve Chartrand, Anouk Whissell, Marc-André Bouvier-Pelletier

Publication Date

Mars 2012
Installing on Mac OS X .................................................................................................................. 3

Pre-installation ................................................................................................................................... 4
Check Your Minimum Requirements ...................................................................................................... 4
Get the Product Activation Code ............................................................................................................ 4
Prerequisites for Harmony Installation ................................................................................................... 4
Editing the hosts File .............................................................................................................................. 4
Editing the launchd.conf File ................................................................................................................. 5
Harmony Installation ............................................................................................................................... 6
Upgrade from a Previous Installation ...................................................................................................... 6
Creating the usabatch User .................................................................................................................... 8
Install Harmony ....................................................................................................................................... 9
Configuration .......................................................................................................................................... 10
Configuring Harmony ............................................................................................................................. 10
Set Up the Database Server .................................................................................................................... 10
Configuring the Licensing .......................................................................................................................... 13
Setting Up the FlexLM License Server .................................................................................................. 13
Setting up the License on Client Workstations ................................................................................... 16
Configuring Harmony to Share Scene Data .......................................................................................... 19
Sharing Harmony Directories for Mac OS X and Linux Clients ............................................................... 19
Sharing the Database for Mac OS X and Linux Clients .......................................................................... 19
Setting up NFS Exports on Mac OS X 10.7 and Mac OS X 10.6 ............................................................ 19
Set Up the Server for Windows Clients ................................................................................................ 22
Configure and Start the Link Server ........................................................................................................ 22
Configure Samba on Mac OS X 10.6 and 10.7 ....................................................................................... 23
Configure the server.ini file .................................................................................................................... 26
Reboot ................................................................................................................................................... 26
Configuring Harmony Clients ............................................................................................................... 27
Mounting NFS Export on Mac OS X 10.6 and 10.7 Clients .................................................................. 27
Renaming your existing /USA_DB and /USADATA directories .............................................................. 27
Configuring the Mounts using the Disk Utility ..................................................................................... 27
Troubleshooting ...................................................................................................................................... 30
Problem: License Error When Starting any Toon Boom Harmony 9.2 Module ................................. 30
Problem: Unable to Import Sample Scene (Errors with the Dbserver) .................................................. 30
Problem: Unable to Open Sample Scene on Clients ............................................................................ 31
Installing on Mac OS X

This document explains how to install Toon Boom Harmony 9.2 on Mac OS X.
This document assumes that you are familiar with Mac OS X networking and are capable of working in a command shell in the Terminal window.

Throughout this document, we will ask you to create files using a text editor. You can use TextEdit, but be sure to convert your files to plain text before saving them in TextEdit.

There are three stages required to install Toon Boom Harmony 9.2, which are covered in the following topics:

1. Pre-installation, on page 4
2. Harmony Installation, on page 6
3. Configuration, on page 10

After completing these stages, you can verify the integrity of the installation and resolve any configuration issues.

• Troubleshooting, on page 30
Pre-installation

Before installing Toon Boom Harmony 9.2, you must perform the following task:
- Prerequisites for Harmony Installation, on page 4

Check Your Minimum Requirements

For the most current Toon Boom Harmony 9.2 hardware requirements, refer to the white paper Harmony and Your IT Department. This is available from:
- Toon Boom Animation Sales Representative
- Toon Boom Animation Support at: support@toonboom.com

Get the Product Activation Code

You should obtain a Product Activation code from the Toon Boom licensor so that you can finish the installation process without having to wait for the activation code to arrive.

To obtain a Toon Boom Harmony 9.2 activation code, please send the following information to: licensor@toonboom.com.
- Your name and the name of your company
- Email address where to send the license file

Prerequisites for Harmony Installation

A DNS server must be configured on the network to be able to run Harmony. All the computers running Harmony must be registered with this server or Harmony will not be able to run properly. If a DNS server is not configured on the Network or if Harmony workstations are having problems resolving the name of the server, the name of the server and each client along with their IP address should be added to the /etc/hosts file on each computer.

Editing the hosts File

1. Make sure the server and all the client workstations are configured with a static (fixed) IP address.
2. Open the Terminal (/Application/Utilities/Terminal).
3. From Terminal go to /etc folder by typing the following:
   ```bash
cd /etc
   ```
4. Create a backup copy of the hosts file. You need to be logged in using the root account to be able to do this. If you are not logged in as the root user, you will need to type sudo before launching the command.
   ```bash
   sudo cp hosts hosts.bak
   ```
5. Edit the /etc/hosts file using the vi text editor. To do this, you need to be logged in with the root account. If not, you must type sudo before launching the command.
   For example: `sudo vi hosts`
6. Once the file is opened in the editor, press the [i] key to trigger the insert mode.
7. Go to the end of the file and add a new line. On this new line, type the static IP address and the machine name (hostname) of the server.
   For example, if the server name is server and the IP address is 192.168.1.1, type `192.168.1.1 server` on this new line. Make sure there is a space between the IP address and the hostname.
   If there is a domain configured on the network, you should also type the fully qualified domain name (FQDN). Add the FQDN after the hostname separating them with a space.
   For example, `192.168.1.1 server server.toonboom.com`
7. Once all the IP and hostnames have been typed, you will need to save the file. To do this, press [ESC] to exit the insert mode.
8. Press the [:] button. The [:] should appear on the bottom of the Terminal, if it does not then you are still in insert mode. Make sure you did not type the colon somewhere in the files and press the ESC key again to exit insert mode.
10. Type the letter \texttt{w}. You should now have the following typed at the bottom of the Terminal:

\texttt{:w}

11. Press the \texttt{return} key. The file was written.

12. To exit \texttt{vi} type \texttt{:q}. You should now have the following at the bottom of the Terminal:

\texttt{:q}

13. Press the \texttt{return} key to quit \texttt{vi}.

The system will return you to /etc in the Terminal.

14. Verify the content of the \texttt{hosts} file by typing:

\texttt{more hosts}

15. Once this is verified, copy and paste the \texttt{hosts} file to all of the client machines.

**Editing the launchd.conf File**

1. Open the Terminal (\texttt{/Applications/Utilities/Terminal}).

2. From Terminal, go to /etc folder by typing the following:

\texttt{cd /etc}

3. If the /etc/launchd.conf file already exists, create a backup copy of it by typing:

\texttt{cp launchd.conf launchd.conf.bak}

4. Edit the /etc/launchd.conf file using the \texttt{vi} text editor. To do this, you must be logged in with the root account. If not, you must type \texttt{sudo} before launching the command.

For example:

\texttt{sudo vi launchd.conf}

5. Once the file has opened in the editor, press the [i] key to trigger the insert mode.

6. At the beginning of the file, add a line with the following text:

\texttt{umask 0}

7. Once finished, you will need to save the file. To do this, press [ESC] to exit the insert mode.

8. Press the [:] button. The : should appear on the bottom of the Terminal,: if it does not, then you are still in insert mode. Make sure you did not type the colon anywhere in the file and press the ESC key again to exit insert mode.

9. Type the letter \texttt{w}. You should now see the following at the bottom of the Terminal:

\texttt{:w}

10. Press the return key. The file is written.

11. To exit \texttt{vi} type \texttt{:q}. You should now see the following at the bottom of the Terminal:

\texttt{:q}

12. Press the return key to quit \texttt{vi}.

The system will return you to /etc in the Terminal.

13. Verify the content of the launchd.conf file by typing:

\texttt{more launchd.conf}. 


Harmony Installation

Now that you have verified your minimum requirements, and configured your hardware and software, you are ready to install Toon Boom Harmony.

You will perform the following tasks:
1. Upgrade from a Previous Installation, on page 6
2. Creating the usabatch User, on page 8
3. Install Harmony, on page 9

Upgrade from a Previous Installation

When upgrading from a previous installation of Toon Boom Harmony or Opus, you should pick a time when Toon Boom Harmony or Opus production is slow or stopped. During the upgrade, no users can run any of the Toon Boom Harmony or Opus modules and all rendering jobs must be complete. To update previous installations:

1. Make sure that no one is running any versions of Toon Boom Harmony or Opus. All Toon Boom Harmony or Opus modules must be closed on the server and on all of the clients.
2. Make sure that all batch rendering and vectorizing is complete or that the queues are empty. You can check the status of the Vectorize and Render queues from the Control Center module.
   - In the Control Center module, use the Queue menu to open the Vectorize and Render Queue for all environments. The Queues should either be empty or the status of all jobs should be “Completed”.
3. Stop all services running on the server and the clients.
   - If you are upgrading from 7.3, 7.8 or 9.2, type in the terminal:
     sudo /sbin/SystemStarter stop ToonBoomQueueServer
     sudo /sbin/SystemStarter stop ToonBoomLinkServer
     sudo /sbin/SystemStarter stop ToonBoomDataBaseServer
     sudo /sbin/SystemStarter stop ToonBoomLicense
   - If you are upgrading from Harmony or Opus 7.2, type the following into the terminal:
     sudo /sbin/SystemStarter stop USAnimation_queues
     sudo /sbin/SystemStarter stop USAnimation_link_srv
     sudo /sbin/SystemStarter stop USAnimation_dbserver
     sudo /sbin/SystemStarter stop USAnimation_flexlm
4. Go to the applicable folder:
   - 9.2: /Applications/Toon Boom Harmony 9.2/tba/etc
   - 7.8: /Applications/Toon Boom Harmony 7.8/tba/etc
   - 7.3: /Applications/Toon Boom Harmony/usa.bundle/etc
   - 7.2: /usa/etc
5. Backup any necessary configuration files.
   - Manager.conf
   - server.ini: if this server is configured to have Windows clients.
   - Scan.conf if this workstation is configured to be a scanning station.
   - VectOptions.conf from any machine (including the server) that is doing batch vectorization.
   - Any other configuration file that is required to be used later.
   - You can backup the whole /Harmony folder to ensure that no configuration file is missed.
6. Go to /usr/local/flexlm/licenses/ (/usa/etc/flexlm/ if you are upgrading from 7.2) folder and backup the license.dat.
7. Then you can delete the /Applications/Toon Boom Harmony folder, or rename it to keep as a backup.
8. If you are upgrading from a previous version of Harmony or Opus, you must delete Startup Items from the previous installation.
   - From /Library/StartupItems/, delete any folders that begin with USAnimation if you are upgrading from 7.2. For example, USAnimation_dbserver. Delete any folders that begin with ToonBoom if you are upgrading from 7.3, 7.8 or 9.2. For example, ToonBoomDatabaseServer.
NOTE:
Depending on the server and client configuration, you may not see any folders starting with Toonboom or USAnimation.
If you are upgrading from Harmony or Opus, you will also need to delete extra files that are located in each users home.

1. Open the Terminal application (/Applications/Utilities/Terminal).
2. Go to a users' home that was configured to work with Harmony. We will use the usabatch account as an example. To do so, type:

   cd /Users/usabatch

3. List all the files in usabatch's home by typing:

   ls -lsa

4. Look for a folder named .MacOSX in the list of files and folders that appear.
5. If the folder is there, delete it with the following command:

   sudo rm -rf .MacOSX

6. Repeat these steps for each user that was configured to work with a previous version of Harmony.
Creating the usabatch User

Before you install Harmony you must create the usabatch user account on the server and on all the workstations that will be doing batch processing (computers that will be part of the batch rendering or vectorizing farm). A number of services, including the tbdserver, license server and batch processing, are started using the usabatch account. In addition to the server, be sure to create the usabatch account on all machines that may perform batch processing. The usabatch account must have administrative rights on the computer.

NOTE:
If you are upgrading from a previous version of Harmony or Opus, you may not need to create the usabatch account since you will use the same account that was created from the previous installation.

To create the usabatch user account:
1. Open System Preferences. By default, there is a shortcut for System Preferences in the Dock.
2. In the System panel of the System Preferences dialog box:
   - 10.6 (Snow Leopard): click Accounts.
   - 10.7 (Lion): click Users & Groups.
   The Password tab of the Accounts window opens.
3. To be able to make changes to the accounts on a Mac, you must first click the lock at the bottom of the window. A dialog box will appear asking you to type your username and password. Type the username and the password of an account that has administrative privileges.
4. Click the + sign button to add a new user.
5. Give the new user the following name, account name and password:
   usabatch
   The usabatch account name and password must be in all lower-case letters.
6. Select Administrator from the drop list next to New Account.
7. Create the account:
   - 10.6 (Snow Leopard): click Create Account.
   - 10.7 (Lion): click Create User.
8. Once the account is created, open the terminal and login as the usabatch user:
   su -l usabatch
9. Make sure you are in usabatch's home folder, then edit or create the .profile for usabatch:
   vi .profile
10. Make sure the file contains the following lines:
    #!/bin/bash
    umask 0
11. Once done, click on [ESC] to exit the insert mode, then type :wq to write the file and exit vi.
Install Harmony

In a client-server network or in a stand-alone set up, you must install Harmony as well as the following services on the server or the stand-alone computer:

- tbdserver: Controls access to the database.
- License service: Controls the number of licenses and features available to Harmony users.
- Batch Processing: Controls batch vectorizing and rendering queues.
- Link server: If you are installing Harmony on a Mac OS X server that will support Windows clients, you must install the Link server.

To install Harmony programs and services, you must run the installation package.

Before you start the installation, you need to make sure you are currently logged in the system with administrative rights on this local computer. You can check it from System Preferences.

1. Open System Preferences. By default, there is a shortcut for System Preferences in the Dock.
2. In the System panel of the System Preferences dialog box:
   - 10.6 (Snow Leopard): click Accounts
   - 10.7 (Lion): click Users & Groups
   The Password tab of the Accounts window opens.
3. Select your user login account and verify if Allow user to administer this computer is checked. If not, please login to the system with an administrative account and do so.

To run the installer:

1. Double-click the Harmony Installer.
2. Follow the on screen instructions until you get to the Standard Install page.
   - To choose the install location, click Change Install Location.
   - To install at the default location, click Install.
3. Follow the rest of the onscreen instructions to complete the installation process.
Configuration

After installing Harmony, you must configure the database parameters and the third party software based on the role this computer will have.

1. Configuring Harmony, on page 10
2. Configuring the Licensing, on page 13

Configuring Harmony

Once Harmony is installed, additional steps are required to configure the database on the server and to setup the Startup Items and register the application path for the Terminal.

1. Set Up the Database Server, on page 10
2. Setting Up the FlexLM License Server, on page 13
3. Setting up the License on Client Workstations, on page 16

Set Up the Database Server

The database server controls all interactions with the contents of the Toon Boom Harmony 9.2 database. It processes all requests to open, read or update files, keeping track of files that are locked so that others cannot edit them.

If you already have a database set up from a previous installation of Toon Boom Harmony 9.2 you DO NOT need to set up the database server, startup items, or register console application in the path. However, if you are upgrading from Harmony 7.8 or from a previous version, you need to install the startup items and register console applications in the path. For new installations of Harmony, you must install all of them.

The database server is configured using the Configuration Assistant:

1. From Finder, go to Applications > Toon Boom Harmony 9.2 > Tools.
2. Double-click Configuration Assistant.
3. For the server, select all three options if this is the first time you are installing on this machine.
   ▶ If you are upgrading from a previous version and a database (/USA_DB) already exists on the server, unselect the Create a new Toon Boom Harmony database option.
   ▶ If you are upgrading from Toon Boom Harmony 7.8 or earlier, you will need to update the dict files in the USA_DB. The dict files need to be copied from /Applications/Toon Boom Harmony 9.2/tba/etc/USADB_templates/dicts/ to /USA_DB/dicts/.
4. Click Continue. The **Create Harmony Database** dialog box opens. The default values shown in this dialog box should be correct and therefore accepted as is.

5. Click on the Create button in the Create Harmony Database dialog box.

**NOTE:**

You can always create the Toon Boom Harmony 9.2 file system manually later. To do so, open terminal and type following:

```
cd / [Return]
mkdir usadata000 [Return]
chmod -R 777 usadata000 [Return]
```

Note that you need to be logged in using the root account to be able to do this. If you are not logged in as the root user, you will need to type sudo before launching the command.

You can make as many data directories as you like. Name these directories using the following syntax, where XXX represents the number of the data directory:

```
usadataXXX
```

**NOTE:**

If you want to use a name other than usadataXXX for the Toon Boom Harmony 9.2 File System, you will need to edit the `Manager.conf` file and add the name or search pattern for this new file system. The `Manager.conf` file can be edited using the **Configuration Editor** that is found in the Tools folder of your Toon Boom Harmony 9.2 installation. Open the Configuration Editor and select the **Manager.conf** tab.
6. In the Create Startup Item page, select the Startup Items required and click Create to continue.

- **Create Database Server Startup Item**: It is mandatory to install the Database Server Startup Item on the server.
- **Create Link Server Startup Item**: This Startup Item is required when there will be Windows clients connecting to the Mac server. This service creates symbolic links when a scene is created from a Windows client workstation.
- **Create Queue Server Startup Item**: This is for the batch rendering. Do not install this on the server, as it will slow it down. Install this on a stand-alone machine that will be used for batch vectorizing or rendering.

7. In the **Register Path** page, choose whether you want to register the path for the current user or for all users.
   - Register Path for all users
   - Register Path for my user only

This option appends the path of Harmony’s applications to the PATH environment variable in order to run the applications from the Terminal.

- **Registration Path for all users**: registers the path for all accounts on the computer. You only need to run this once.
- **Registration Path for my user only**: This option registers the path to the current account only. You need to run this for each user that will be using the Terminal and you need to run this each time you create a new user.

8. Click **Create** to go to the next page.

9. Click **Done** to close the Configuration Assistant.
Configuring the Licensing

The licensing must be configured before running Toon Boom Harmony 9.2.

You must perform the following tasks on the server:

- Setting Up the FlexLM License Server, on page 13
- Setting up the License on Client Workstations, on page 16

Setting Up the FlexLM License Server

Configuring the license server

1. Launch the License Wizard from Applications > Toon Boom Harmony 9.2 > Tools > LicenseWizard.
2. Depending on how the License Wizard was started, the first page of the License Wizard will be one of the following:
   - If this screen appears: Click on More Options.
   - If this screen appears: Click on Activate License.
The Activation Options screen appears:

**Activation Options**

There are multiple ways to activate your copy of Harmony:

1. Click on the ‘Internet Activation’ button if your computer is connected and configured for internet access.

2. Click on the “Alternative Activation” button if you are a single user and your computer is not connected to the internet.

3. Now that you have activated your license server, click on the “Use License Server” button to connect your computer to the license server.

4. Click on “Use Text License File” to install a license file. Your computer does not need to be connected to the internet.

3. **Click on Internet Activation**

   The Internet Activation Options screen appears:

   **Internet Activation Options**

   In this step you must select the type of license activation.

   1. To install a single license for this computer only, click on the “Single user” button. If your license is for multiple computers, you need to repeat the activation steps on each one.

   2. If this computer is your server, click on the “Network License” button to install a license server which will broadcast licenses to computers on your network.

   3. To upgrade a currently installed license on this computer, click on the “Upgrade License” button.

4. **Click on Network License.**
The **Internet Activation - Network License** screen appears:

5. Type or copy/paste the **Product Code** and type in the number of licenses (License Count) this product code grants you.
   
   **NOTE:** Once activated, server license cannot be returned to the activation server. Make sure you are activating the license on the correct computer with the proper license count.

6. Click on **Activate**.
   
   The **Install License Server** screen appears:

7. Click on **Install License Server**.
   
   This step will create the license.dat file and place it in `/usr/local/flexlm/licenses/license.dat`. It will also configure and start the License Server service.

   The license.dat created contains the following information:

   ```
   SERVER this_host 0 ANY
   VENDOR toonboom
   USE_SERVER
   ```
8. Click on Finish to exit the wizard.
9. Verify that the FlexLM license is working properly by using the `lmutil lmstat -a` command.
   ```bash
lmutil lmstat -a
   
   You can also look at the ToonBoomLicense.log that is located at:
   ```
   ```bash
   /Library/Logs/ToonBoomLicense.log
   
   10. If the FlexLM service needs to be restarted, use the following command:
   ```
   ```bash
   sudo /sbin/SystemStarter restart ToonBoomLicense
   ```

### Setting up the License on Client Workstations

An Admin account is required to set this up. After activation you can login as client. To set up the license on a client workstation do the following:

1. Open the LicenseWizard on the Client machine. The LicenseWizard appears.
2. **Click on Activate License.** The Activation Options screen appears.

![Activation Options Screen]

3. **Click on Use License Server.** The Server Activation Options screen appears.

![Server Activation Options Screen]
4. Click on **Connect to Server**. The Server Activation - Shared License dialog appears.

![Server Activation - Shared License dialog](image)

5. Enter the hostname or the IP Address in the License Server address field.
6. Click Connect. You will be prompted for a password.
7. Enter the password and click ok. The Activation Successful screen appears.
8. Click **Finish** to close the LicenseWizard.
Configuring Harmony to Share Scene Data

Before you can share scene data between a Mac OS X database and Mac OS X, Linux, and Windows clients, you must configure the Mac OS X database server appropriately.

This section covers the following topics:

- Sharing Harmony Directories for Mac OS X and Linux Clients, on page 19
- Set Up the Server for Windows Clients, on page 22

Sharing Harmony Directories for Mac OS X and Linux Clients

To share scene data between the Mac OS X server and Mac OS X and Linux clients, you must export (using NFS) the database and data directories from the server.

Toon Boom Harmony 9.2 uses NFS (Network File System) to share files between Mac OS X and Linux computers. You must use NFS to export directories from the server so that clients can mount them and share the contents.

This section covers the following topics:

- Sharing the Database for Mac OS X and Linux Clients, on page 19
- Setting up NFS Exports on Mac OS X 10.7 and Mac OS X 10.6, on page 19

Sharing the Database for Mac OS X and Linux Clients

If your Mac OS X server will have Mac OS X or Linux clients, you will need to export the USA_DB and USADATA folders using NFS (network file server). In turn the clients will need to be configured to mount those exported folders from the server.

Setting up NFS Exports on Mac OS X 10.7 and Mac OS X 10.6

The following procedure demonstrate how to export the /USADATA and the /USA_DB directories, on a Mac OS X workstation, as NFS Shared points.

1. From Finder go to Application > Utilities and double-click Terminal.
2. Create and edit the export file in the /etc directory, by typing the following:

```
sudo vi /etc/exports.
```

3. Click on "i" to enter the "insert" mode and type the following lines:

```
/USA_DB   -maproot=nobody -network 192.168.0.0 -mask 255.255.0.0
/USADATA   -maproot=nobody -network 192.168.0.0 -mask 255.255.0.0
```

**NOTE:**
- `network` and `mask` are optional. They are used to restrict the connections to the NFS server to computers in a specific address range. In this example, the local network addresses are within 192.168. If your local network uses another set of Private IP Address (such as 10. or 172.16.) use this one instead.

4. Once done, click on [ESC] to exit the insert mode, then type `:wq` to write the file and exit `vi`.

5. Check that the file is correct by running:
sudo nfsd checkexports

NOTE:
If there is no return response, then all is correct.

6. Type the following command to start nfsd.
   
sudo nfsd enable

7. If nfsd was already started, you will need to type the following command to notify the nfsd daemon that the /etc/exports file has changed:
   
sudo kill -1 `cat /var/run/mountd.pid`

   NOTE: the ` character is located on the top left side of the Mac keyboard on the same key as the tilde ~ character.

8. Once that is done, you can use the following command to see if the folders are exported correctly:
   
   /usr/bin/showmount -e

   The following should appear after running the command.

   /USA_DB 192.168.0.0

   /USADATA 192.168.0.0

Once the exports file is created, clients systems will be able to mount the /USA_DB and /USADATA located on the Mac OS X server system.
Set Up the Server for Windows Clients

If Windows clients are going to access the Toon Boom Harmony 9.2 database on a Mac OS X server, you must set up the Link Server, Samba and the server.ini file. These allow the server and clients to communicate and share data.

To set up the server for Windows clients, you must:
1. Configure and Start the Link Server, on page 22.
2. Configure Samba on Mac OS X 10.6 and 10.7, on page 23.

Configure and Start the Link Server

If you are running Toon Boom Harmony 9.2 in a mixed environment where the server is on Mac and some of the clients are running Windows, you must start the Link Server. The Link Server makes it possible for Windows machines to communicate with the database.

To configure the link server on the server in a mixed network environment:
1. If you did not already install Link Server during the server installation, you must do it now. From the Finder, go to Applications > Toon Boom Harmony 9.2 > Tools.
2. Double-click the Configuration Assistant.
3. Select Create the Startup Items and uncheck the other options.
4. Click on the Continue button.
5. In Create Startup Item, select Create Link Server Startup Item and click Create.
6. Type a user name and password of a user with administration rights, click OK to confirm.
7. To start the Link Server, either restart the server or type the following in the Terminal. (Note: if you are not a root, you need to use sudo command):
   
   ```
   sudo /sbin/SystemStarter start ToonBoomLinkServer
   ```
   
   A message will appear in the Terminal indicating that the script has been successful.
8. A log file will be generated in /Library/Logs/ToonBoomLinkServer.log. Check this file to make sure there are no errors written to this file.
**Configure Samba on Mac OS X 10.6 and 10.7**

Do the following:

- Configure the Samba Service
- Configure the samba shared files
- Configure the smb.conf file

> **Mac OS X 10.7 (Lion) no longer uses the open source Samba software to share folders for Windows workstations. It has been replaced by Apple's own Windows file sharing software. This software does not include some of the options required to support Windows Harmony clients. We are seeking a solution to this problem. In the mean time, if you need to have Windows clients in your environment, Mac OS X 10.6 or a Linux server can be used.**

**Configure the Samba Service**

By default, Samba is not set up to run automatically on Mac OS X.

**To start the Samba service:**

1. Open *System Preferences*.
2. In the *Internet & Wireless* section, click on *Sharing*.
3. In the *Services* section, click in the *File Sharing* checkbox.

![System Preferences](image)

4. Under the *Shared Folders* section, click on the plus + sign.
5. Browse and select the */USA_DB* folder.

![Shared Folders](image)

6. Repeat Step 4 and Step 5 for the */USADATA* folder.
7. Make sure to give the *usabatch* account Read and Write permissions to the *USA_DB* and *USADATA* folders.
8. Click on the *Options* button.
9. Enable the Share files and folders using SMB checkbox.

10. Click the usabatch account checkbox in the account list and then click Done.

11. Close System Preferences.

Configure the samba shared files

Next, modify the usa_db and the usadata shares in the /var/db/samba/smb.shares and add a usa section to the file.

12. Open the Terminal. In the Finder go to Application > Utilities and double-click Terminal.

13. Go to the samba shares directory:
   ```
   cd /var/db/samba/
   ```

14. Open the `smb.shares` file in the vi text editor.
   ```
   sudo vi smb.shares
   ```

15. Type “i” to enter the insert mode.

16. Add or modify options in the file.
   
   This is an example of entries in the `smb.shares` shared file. You can add missing options at the end of the list.

   ```
   [USA_DB]
   comment = Harmony database folder
   path = /USA_DB
   available = yes
   guest ok = no
   directory mask = 777
   create mask = 777
   browseable=yes
   read only=no
   
   [USADATA]
   comment = Harmony USADATA filesystem
   path = /USADATA
   available = yes
   guest ok = no
   directory mask = 777
   create mask = 777
   browseable=yes
   read only=no
   ```
17. Create a `usa` share by making a copy of the `[USA_DB]` section and pasting it underneath.
19. Modify the following lines under `[USA]`:

   ```
   path = /Applications/Toon Boom Harmony 9.2/tba
   comment = Harmony binaries and configuration files
   ```

20. Verify that the `[USA]` section looks like the following:

   ```
   [usa]
   comment = Harmony binaries and configuration files
   path = /Applications/Toon Boom Harmony 9.2/tba
   available = yes
   guest ok = no
   directory mask = 777
   create mask = 777
   browseable = yes
   read only = no
   ```

21. Type `[ESC]` and type `:wq` to save the changes and quit the `vi` editor.

Configure the `smb.conf` file
You must also either add or modify the following entries to the `[global]` section of `/etc/smb.conf` file.

22. Create a backup copy of your current `/etc/smb.conf` file:

   ```
   cd /etc
   sudo cp smb.conf smb.conf.bak
   ```

23. Open the `smb.conf` file in the `vi` editor.

   ```
   sudo vi /etc/smb.conf
   ```

24. Type “`i`” to enter the insert mode.
25. Add or modify options in the file:

   ```
   [global]
   map to guest = Never
   dos charset = 437
   unix charset = UTF-8-MAC
   display charset = UTF-8-MAC
   blocking locks = false
   oplocks = false
   mangled names = no
   ```

   **NOTE:** When set to no, the mangled name parameter will prevent older smb clients (DOS, Win9X and Windows NT clients) to access files and folders that do not use a 8.3 file name.

26. Type `[ESC]` [escape] to quit the insert mode.
27. Type `:wq` to save the changes and quit the `vi` editor.
28. Once the file is saved, run the “testparm” command to check that you have not made any basic syntactic errors.

   ```
   testparm
   ```
29. Notify the `smbd` service of the changes by typing the following:

   ```bash
   sudo kill -l `cat /var/run/smbd.pid`
   ```

   NOTE: the `` character is located on the top left side of the Mac keyboard on the same key as the tilde `~` character. Or simply reboot the computer.

Configure the server.ini file

Before you install Toon Boom Harmony 9.2 on Windows clients, you must create the `server.ini` file on the server. The `server.ini` file provides information necessary in Windows for the Configuration Wizard to set up a Windows client.

NOTE: When creating the `server.ini` file, be attentive to spelling, character spacing and case.

To create the `server.ini` on the Mac server:

1. In Finder, go to `Application > Toon Boom Harmony 9.2 > Tools` and double-click the Configuration Editor.

2. When the `Configuration Editor` opens, click on the `server.ini` tab.

3. Copy and paste this example and modify it accordingly:

   ```ini
   [WizardConfig]
   ServerName=harmonyserver
   InstallationDrive=C
   UsaShare=usa
   UsadbDrive=C
   UsadbShare=USA_DB
   FileSystem0=C USADATA harmonyserver
   ```

   The references to `DriveC` shown in this example are necessary for Windows clients and will be ignored by Mac OS X.

4. Save the file using the Save command under the File menu and quit the Configuration Editor.

Reboot

At this point, you should reboot the server so that all of the services which you have just configured will start up.
Configuring Harmony Clients

Mounting NFS Export on Mac OS X 10.6 and 10.7 Clients

The following procedure demonstrates how to mount the /USADATA and the /USA_DB server directories, on a Mac OS X 10.6 or 10.7 workstation, as NSF Shared points.

Renaming your existing /USA_DB and /USADATA directories

**NOTE:** This only applies if you already have a /USA_DB and a /USADATA local directory. Before starting, you must rename these directories if you want to keep their contents.

To rename /USA_DB and /USADATA local directories:

1. Open the Terminal. From the Finder go to Application > Utilities and double-click Terminal.
2. Rename the local USA_DB and USADATA directories, by typing the following:

   ```
   sudo mv /USA_DB /USA_DB.BAK
   sudo mv /USADATA /USADATA.BAK
   ```

Configuring the Mounts using the Disk Utility

1. In the Finder go to Application > Utilities and double-click on Disk Utility.
2. In Disk Utility, click on File > NFS Mounts. The NFS Mounts window will open.
3. Press the [+] button in the toolbar below the panel.
4. In the Remote NFS URL field type the following:

   ```
   nfs://[server name]/USA_DB
   ```

   **NOTE:** Replace [server name] by the name of the server. For example, if the server name was jarjar, you would type: nfs://jarjar/USA_DB.
5. In the Mount Location field type the following:

   ```
   /Volumes/USA_DB
   ```
6. If the workstation is going to be connecting to a Linux server, you must edit the Advanced Mount Parameters. In the Advanced Mount Parameters field, type:

```
resvport
```

7. Click on the Verify button.
8. Click on the OK button on the message that confirms that NFS server is functional.
9. Repeat Step 3 through Step 8, but enter the following for the Remote NFS URL and Mount Location:

```
nfs://[server hostname]/USADATA
/Volumes/USADATA
```

10. Press the Save button and enter your user password to confirm the changes. Note that on Mac OS X 10.7 there is no save button. Changes are automatically saved and applied when the NFS Mounts window is closed.
11. Quit the Disk Utility.
12. Open a new Terminal window.
13. Verify that the /USA_DB and /USADATA shared points have been mounted properly:

```
ls /Volumes/USA_DB
```

and

```
ls /Volumes/USADATA
```

14. Create symbolic links to the USA_DB and USADATA directories at the root level:

```
sudo ln -s /Volumes/USA_DB /USA_DB
```
sudo ln -s /Volumes/USADATA /USADATA

15. Verify that the symbolic links are pointing to the right directories:

```bash
ls -l /
```

The symbolic links for the /USA_DB and /USADATA should look like the following:

```
USADATA -> /Volumes/USADATA
USA_DB -> /Volumes/USA_DB
```
Troubleshooting

If you have any problems running Harmony after the installation, review the installation and configuration instructions to make sure you have followed them completely. If you continue to have problems, consult the following list to troubleshoot common installation and configuration problems.

• Problem: License Error When Starting any Toon Boom Harmony 9.2 Module, on page 30
• Problem: Unable to Import Sample Scene (Errors with the Dbserver), on page 30
• Problem: Unable to Open Sample Scene on Clients, on page 31

Problem: License Error When Starting any Toon Boom Harmony 9.2 Module

If you are getting license errors when you start a Toon Boom Harmony 9.2 module, check the set up and configuration of the license service.

• On the license server, make sure that the license.dat file is in the following directory:
  /usr/local/flexlm/licenses
• The license.dat should contain the following information:

```plaintext
SERVER this_host 0 ANY
VENDOR toonboom
USE_SERVER.
```

• Open the Activity monitor and make sure that the lmgrd and toonboom processes are running. If both of them are missing, you can start the license by typing the following in the Terminal:

```
sudo /sbin/SystemStarter start ToonBoomLicense
```

The following line should appear followed by messages from lmgrd:

```
Starting Toon Boom License Daemon...
```

• If you get an error message when you try to start the license service, it is possible that you did not install the license Startup Item. Use the LicenseWizard to install license server Startup Item. Refer to, Setting Up the FlexLM License Server, on page 13.

• If you continue having problems with the license server, locate the file ToonBoomLicense.log and send it to support@toonboom.com. The file is located in: /Library/Logs and can be accessed from the Console application.

Problem: Unable to Import Sample Scene (Errors with the Dbserver)

• Check the ToonBoomDatabaseServer.log file. The file is located in /Library/Logs and can be accessed from the Console application.
  If there is no log file, restart the Dbserver. Type the following in a Terminal window:

```
sudo /sbin/SystemStarter start ToonBoomDatabaseServer
```

If there is a log file, the last few lines in the log file will give you some indication as to the problem with the Dbserver.

• If you get an error in the log about the machine name, check the /USA_DB/Dbserver.conf file and make sure the hostname matches the machine name of the Toon Boom Harmony 9.2 server.

• If you get errors about the port number, another service might be using port 5680. You can change the port number in Dbserver.conf to any unused number above 5000.

• Restart the Dbserver. Type the following in a shell:

```
sudo /sbin/SystemStarter start ToonBoomDatabaseServer
```
Problem: Unable to Open Sample Scene on Clients

- On the Toon Boom Harmony 9.2 server, verify:
  - The database and data directories were exported using NFS. Sharing Harmony Directories for Mac OS X and Linux Clients, on page 19
  - Link Server, Samba and server.ini configurations for Windows clients. Set Up the Server for Windows Clients, on page 22

- On Mac OS X Toon Boom Harmony 9.2 clients, check that the database and data directories were mounted using NFS. Sharing the Database for Mac OS X and Linux Clients, on page 19.